USER GUIDE

SCC-FT01 Feedthrough Module
The SCC-FT01 is a feedthrough module that connects directly to the
analog input (AI) and analog output (AO) channels of a data acquisition
(DAQ) device. You can use the breadboard area of the SCC-FT01 to
develop custom signal-conditioning circuitry that can connect to and
condition any of the analog, digital (P0.), and general-purpose
counter/timer (CTR) channels of E Series DAQ devices.

Conventions
The following conventions are used in this guide:
<>

Angle brackets that contain numbers separated by an ellipsis represent
a range of values associated with a bit or signal name—for example,
AI <0..7>.

»

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.
This icon denotes a note, which alerts you to important information.
This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on
the product, refer to the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.
When symbol is marked on a product it denotes a warning advising you to
take precautions to avoid electrical shock.
When symbol is marked on a product it denotes a component that may be
hot. Touching this component may result in bodily injury.

bold

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

italic

Italic text denotes variables, emphasis, a cross reference, a hardware label,
or an introduction to a key concept. This font also denotes text that is a
placeholder for a word or value that you must supply.

monospace

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

SC-2345

SC-2345 refers to both the SC-2345 connector block and the SC-2345 with
configurable connectors.

SCC

SCC refers to any SCC series signal conditioning module.

What You Need to Get Started
To set up and use the SCC-FT01, you need the following items:

❑ SC-2345/2350 with one of the following:
–

SCC-PWR01

–

SCC-PWR02 and the PS01 power supply

–

SCC-PWR03 (requires a 7 to 42 VDC power supply, not included)

❑ One or more SCC-FT01 modules
❑ SCC-FT01 Feedthrough Module User Guide
❑ SC-2345/2350 User Manual, available at ni.com
❑ SCC Quick Start Guide, available at ni.com
❑ Read Me First: Safety and Radio-Frequency Interference
❑ SC-2345 Quick Reference Label
❑ 68-pin E Series DAQ device, documentation, and 68-pin cable of
1 or 2 m length

❑ 1/8 in. flathead screwdriver
❑ Numbers 1 and 2 Phillips screwdrivers
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❑ Wire insulation strippers
❑ NI-DAQ (current version) for Windows 2000/NT/XP/Me
If you do not have the current version of NI-DAQ or one of the
documents, you can download them from ni.com, or contact an
NI sales representative.
Software scaling of measurements is not supported on the Macintosh operating
system.

Note

Device Specific Information
For general SCC module installation and signal connection information, and
information about the SC-2350 carrier, refer to the SCC Quick Start Guide, available
for download at ni.com/manuals.

Note

Installing the Module
Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting/disconnecting any signal wires.

If you plug the unmodified SCC-FT01 into any SCC socket other than
single-stage AI (sockets J1 through J8) or AO (sockets J17 and J18), you can damage
the E Series DAQ device.

Caution

You can plug the SCC-FT01, as shipped, into an AI or AO socket on the
SC-2345. When used as a prototyping module, the SCC-FT01 plugs into
any socket on the SC-2345 except the power socket.
Five 0 Ω resistors on the printed circuit board (PCB) connect a set of default
signals listed on the module label. To modify the SCC-FT01 to perform
custom signal conditioning, refer to the Customizing the SCC-FT01
section.

Connecting the Input Signals
The signal names have changed. Refer to ni.com/info and enter rdtntg to
confirm the signal names.

Note

The screw terminals are labeled by pin number <1..6>. The module label
lists the signal names beside the pin numbers. Pins 2 through 6 accept the
following signals: CH+, CH–, AI GND, AI SENSE, and EXT REF. Pin 1
does not connect to anything. Connect the wires accordingly.
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Table 1 shows the signals available if you plug the SCC-FT01 into
AI single-stage SCC sockets J1–J8 or AO SCC sockets J17 and J18.
Table 1. SCC-FT01 Signals

Screw
Terminal
Number

Screw
Terminal Label

AI Single-Stage
SCC Socket
J1–J8

AO SCC
Socket J17

AO SCC
Socket J18

6

CH+

AI

AO 0

AO 1

5

CH–

AI +8

AO GND

AO GND

4

AI GND

AI GND

PFI 5

PFI 5

3

AI SENSE

AI SENSE

AO 1

AO 0

2

EXT REF

—

EXT REF

EXT REF

1

NO CONNECT

—

—

—

When you plug the SCC-FT01 into a single-stage AI SCC socket, the
following conditions are true for the labeled screw terminals:
•

CH+ connects to the lower AI channel number CH(X), where
X is 0 to 7.

•

CH– connects to the higher AI channel number CH(X+8), where
X is 0 to 7.

•

AI GND connects to AI ground.

•

AI SENSE connects to AI SENSE.

•

EXT REF does not connect—do not use it.

Note For information on AI modes, refer to the SC-2345 User Manual. For information
on AI configuration modes, refer to the DAQ device documentation.

When you plug the SCC-FT01 into an AO SCC socket, the following
conditions are true for the labeled screw terminals:
•

CH+ connects to AO 0 for AO SCC socket J17, AO1 for
AO SCC socket J18.

•

CH– connects to AO ground.

•

AI GND connects to PFI 5.

•

AI SENSE connects to AO 1 for AO SCC socket J17, AO 0 for
AO SCC socket J18.

•

EXT REF connects to EXT REF.
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When you configure the SC-2345 as an accessory to the E Series DAQ
device in Measurement & Automation Explorer (MAX), the program
automatically configures the SC-2345 in nonreferenced single-ended
(NRSE) mode. Connect the signal source to single-ended channels on the
SCC-FT01 while the SC-2345 is configured in the NRSE AI configuration.
You can configure the E Series DAQ device to read signals from the
SCC-FT01 in differential mode. Use a virtual channel in MAX or
application software to configure the E Series DAQ device to read the
signal in differential mode. When you read a signal in differential mode,
you use two channels for one measurement, but you avoid ground loops and
get a better signal by rejecting common-mode signal noise.
You can configure the E Series DAQ device on a per channel basis with
application software or virtual channels. For example, you can have
channels 0 and 8 in differential mode and 1 to 7 and 9 to 15 in NRSE mode.
Refer to the Measurement & Automation Explorer Help for more
information and instructions on configuring channels.
For more information about configuring the SCC-FT01 using NI-DAQmx,
refer to the SCC Quick Start Guide.

Customizing the SCC-FT01
You can customize the SCC-FT01 to connect to any of the AI, AO, digital
input/output, or counter signals of the E Series DAQ device. After you
customize the SCC-FT01, you can plug it into any SCC socket on
the SC-2345 except the SCC power socket. The SCC-FT01 PCB
contains 2.54 sq cm (1 sq in.) of prototyping breadboard area. This area
accommodates as many as four 8-pin integrated circuits and other discrete
components such as resistors and capacitors.
Place the SCC-FT01 prototyping module label, which is included in the kit,
over the SCC-FT01 feedthrough module label on the SCC enclosure. This
label does not contain signal names, so you can customize the assignment
of the screw terminals.

Circuit Design
You must disassemble the SCC-FT01 to install custom circuitry.
Complete the following steps to open the module.
1.

Remove the screw from the back (wide unlabeled side).

2.

Turn the front (wide labeled side) toward you.

3.

Place the screw terminal receptacle on the left.
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4.

Slide the top cover to the right.

5.

Lift off the cover.

You must remove resistors R1 through R5, shown in Figure 1, before you
develop custom circuitry. The signal connection pads above connector J2,
represented by item 1 in Figure 1, connect to different signals on the
E Series DAQ device, depending on where you install the SCC-FT01 on the
SC-2345.

1

2

3

4

1
2

I/O Pads
Prototyping Breadboard Area

3
4

Signal Connection Pads
R1 through R5

Figure 1. SCC-FT01 Parts Locator Diagram

Table 2 shows the signals available for circuit design when you plug the
SCC-FT01 into each type of SCC socket on the SC-2345. The pad numbers
correspond to the number next to each pad on the SCC-FT01.
Table 2. Signals Available by SCC Socket Type
Signal Name
Pad
Number

AI/P0.

All

AO

CTR CH0

CTR CH1

1

AI SENSE

–15 V

EXT REF

PFI 8/
CT R0 SOURCE

PFI 3/
CTR 1 SOURCE

2

AI +

REF 5 V

J17—AO 1

PFI 6/
AO START TRIG
or
AI – Cascaded
REF 1

EXTSTROBE*
or
AI – Cascaded
REF 1

J18—AO 0
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Table 2. Signals Available by SCC Socket Type (Continued)
Signal Name
Pad
Number

AI/P0.

All

AO

CTR CH0

CTR CH1

3

AI GND

GND (+5 V)

AO GND(B)

N/A
or
AI + Cascaded
REF 1

PFI 1/AI REF
TRIG
or
AI + Cascaded
REF 1

4

PFI 7/
AI SAMPLE C
LK or
P0.(X) 2

+15 V

AO GND(A)

FREQ OUT

FREQ OUT

5

AI –

GND (15 V
and REF 5 V)

J17—AO 0

PFI 5/
AO SAMP
CLOCK

AI HOLD COMP

+5 V

PFI 6/
AO START TRIG

P0.6

P0.7

PFI 0/
AI START TRIG

PFI 0/
AI START TRIG

J18—AO 1

6

AI + Cascaded 3

7

AI – Cascaded 3

—

PFI 5/
AO SAMP CLOCK

AI SENSE
Cascaded 3

—

—

8

—

PFI 7/
AI SAMP CLK

9

—

—

—

PFI 9/
CTR 0 GATE

PFI 4/
CTR 1 GATE

10

—

—

—

CTR 0 OUT

CTR 1 OUT

1 Not a counter signal name. Available on any AI SCC socket J1 to J8.
2 Available on digital SCC sockets (J9 to J16) only.
3 Available on final-stage AI SCC sockets (J1 to J8) only.

AO GND (A) and AO GND (B) are both in the table, but both connect to the one
AO GND signal on the E Series DAQ device.

Note

An SCC-FT01 signal connection label, which defines the pad numbers
on the SCC-FT01 board, is attached to the inside of the enclosure of the
SCC module.
Whether you plug the SCC-FT01 into an SCC socket for AI, AO, digital,
or counter conditioning, the pads listed under the All column in Table 2 are
connected, and you can use them.
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Wiring the SCC-FT01
The signal names in the following sections refer to the signals listed in
Table 2.
When you plug the SCC-FT01 into the first-stage AI sockets on the SC-2345, you
do not connect the outputs of the circuitry to the pads labeled Cascaded. Use pads labeled
Cascaded only when you plug the SCC-FT01 into the second-stage (final-stage) socket to
get the input signals through the SC-2345 from the first-stage socket. Refer to Figures 2a
and 2b.
Note

AI +
AI GND

6
5
4
3
2
1

6
5
4
3
2
1

a. First-Stage Analog Input Mode

Prototyping
Circuit

SCC-FT01 Prototype

SCC-FT01 Prototype

AI +
AI GND
AI + Cascaded REF
AI + Cascaded

b. Second-Stage Analog Input Mode
SCC-FT01 Prototype
AI +
AI GND

6
5
4
3
2
1

AI –

c. Single-Stage Analog Input Mode

Figure 2. SCC-FT01 Prototyping Module AI Configurations

Figures 2a and 2b illustrate example wiring for the SCC-FT01 prototyping
module used in dual-stage AI configuration. Figure 2c illustrates
single-stage AI configuration.

Analog Input and Digital Input/Output
To use the SCC-FT01 for AI or digital signal conditioning, use the pads
above connector J2 labeled AI/P0. for connections to the breadboard area.
You then can plug the module into any AI SCC socket J1 to J16 on the
SC-2345. The signals available are slightly different when the module is
plugged into the first-stage AI (also known as digital) than when plugged
into the second-stage AI (also known as single-stage AI). Use SCC sockets
J9 to J16 for first-stage AI. Use SCC sockets J1 to J8 for second-stage AI.
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PFI 7/AI SAMP CLK, AI + Cascaded, AI + Cascaded REF,
AI – Cascaded, AI – Cascaded REF, and AI SENSE Cascaded signals are
available for the second-stage AI SCC sockets only. The P0.(X) signal is
available for the first-stage AI SCC sockets only. Refer to Table 2 for pad
definitions.
When the E Series DAQ device is configured in NRSE AI mode, design
your prototype circuitry so that the output of the SCC-FT01 to the E Series
DAQ device is referenced single-ended to AI GND on the SC-2345.
Note

On the SC-2345, the AI GND and AI SENSE signals join at connector J24.

Analog Output
To use the SCC-FT01 for AO signal conditioning, use the pads above
connector J2 labeled AO for connections to the breadboard area. The
AO column in Table 2 lists the signals available to each pad. Plug the
SCC-FT01 into any AO socket on the SC-2345.
The AO 0 and AO 1 signals depend on which AO SCC socket you use.
If you plug the SCC-FT01 into the AO SCC socket J17, the DAC (A) pad
connects to AO 0 and the DAC (B) pad to AO 1 on the E Series DAQ
device. These pad connections are reversed when the SCC-FT01 is plugged
into AO SCC socket J18, and the DAC (A) pad connects to AO 1 and
DAC (B) pad to AO 0 on the E Series DAQ device.

Counter
To use the SCC-FT01 for CTR functions, use the pads above connector J2
labeled CTR for connections to the breadboard area. The CTR CH0 and
CTR CH1 columns in Table 2 list the signals available to each pad. The
signals available depend on which SCC socket you use.
If you plug the SCC-FT01 into the CTR CH0 socket J19, the pads under
CTR CH0 on the board connect to signals associated with CTR channel 0
and AO of the E Series DAQ device. When the SCC-FT01 is plugged into
the CTR CH1 socket J20, the pads under CTR CH1 on the board connect
to signals associated with CTR channel 1 and AI of the E Series DAQ
device.
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Connecting the Screw Terminals
The pads next to connector J1 connect to each input of the screw terminal
connector. Use these pads to connect the external signals to the circuitry
you added in the breadboard area. The numbers next to each hole
correspond to the screw terminal numbers. Space is available on the
SCC-FT01 prototyping module label for custom signal names.
For information about how to configure the SCC-FT01 module using
NI-DAQmx, refer to the SCC Quick Start Guide.

Specifications
These ratings are typical at 25 °C unless otherwise stated.

Analog
Number of input channels.......................1 DIFF or 2 SE (when plugged
into an AI socket on the SC-2345)
Number of output channels.....................1 (when plugged into an
AO socket on the SC-2345)

Power Requirement
No power required (if unmodified)

Physical
Dimensions .............................................8.89 cm × 2.92 cm × 1.85 cm
(3.50 in. × 1.15 in. × 0.73 in.)
I/O connectors.........................................20-pin right-angle male connector
6-pin screw terminal system
Screw terminal ........................................28 to 16 AWG

Safety
This product is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control,
and laboratory use:
•

IEC 61010-1, EN 61010-1

•

UL 3111-1, UL 61010B-1

•

CAN/CSA C22.2 No. 1010.1
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Note For UL and other safety certifications, refer to the product label, or visit
ni.com/hardref.nsf, search by model number or product line, and click the

appropriate link in the Certification column.

Electromagnetic Compatibility
Emissions................................................EN 55011 Class A at 10 m
FCC Part 15A above 1 GHz
Immunity ................................................EN 61326:1997/ + A2:2001,
Table 1
CE, C-Tick, and FCC Part 15 (Class A) Compliant
For full EMC compliance, operate this device with shielded cabling. In addition,
all covers and filler panels must be installed.

Note

CE Compliance
This product meets the essential requirements of applicable European
Directives, as amended for CE marking, as follows:
Low-Voltage Directive (safety)..............73/23/EEC
Electromagnetic Compatibility
Directive (EMC) .....................................89/336/EEC
Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit
ni.com/hardref.nsf, search by model number or product line, and click the
appropriate link in the Certification column.
Note

National Instruments™, NI™, ni.com™, and NI-DAQ™ are trademarks of National Instruments
Corporation. Product and company names mentioned herein are trademarks or trade names of their
respective companies. For patents covering National Instruments products, refer to the appropriate
location: Help»Patents in your software, the patents.txt file on your CD, or ni.com/patents.
© 2002–2004 National Instruments Corp. All rights reserved.
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